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Open Data Protocol (OData)

Open Data Protocol (OData) is an "open" application-level protocol for interacting with data via RESTful
APIs. It supports the description of data models, and the editing and querying of data according to those
models, in a simple and standard way.

This document will provide a quick guide for the configuration of an OData data source to easily retrieve
MES data that can be used for advanced analysis in external tools.

Overview

OData is a widely accepted standard that is supported by Analytics tools such as Microsoft Excel, Microsoft
Power BI, Tableau, QlikView among many others. To provide easy interoperability, and provide quick and
simple access to MES data, which can then be used for any sort of user advanced analysis (and

Configuration

First of all, if the required data is not already covered by an existing MES Query, you should create a new

You can select the Endpoint button on the top ribbon in either the main Queries page or a specific Query
page and get the specific endpoint for the OData API:

¥ & T V| &

Create mefresh Import Export Endpolnt

£ Queries

QUERIES =

All Queries QUERY DESCRIPTION ENTITY TYPE

FOLDERS i CertificationManagedByMeQuery Certification
chartByTypeOrParameter Chart

ol Queries o
GetAllMarerialTransfers Retrieves all MaterialTransfers in the syst.. MaterialTransfer
GetAreaByFacility Area
GetCertificationEmployeeQuery EmployeeCertification
GetDurablesForResourceViewQuery ResourceDurable
GetEmployeeForCertificationQuery EmployeeCertification
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Refresh Export Setings Delete Generate  Execute Endpaint

,o:ﬁ GetExperimentsQuery

> FILTERS (0)

~ RESULTS(2)

; NAME DESCRIPTION -‘ EXPERIMENTDERANITION . MATERIAL STARTDATE
E£1-000000001 E1 LOT1 09/24/2020 02:36 PM
E2-000000001 E2 LoT2 09/24/2020 02:39 PM

In either situation, a new wizard will open with an option to copy the endpoint URL and use it when

configuring the access on the external tool.

OData

OData Endpoint
Please make sure you have a valid Access Token for Authentication.

https://VM-PROD-Cl_.cmf.criticalmanufacturing.com:10102/api/

Close

Access Token

authentication. For that, you should open your User page and go to the Access Tokens section:
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Select the Create button on the top ribbon, fill in @ meaningful name (important in case you need to
invalidate the token in future), set an expiration date, select Create and then copy the new token:

Access Token

Access Token was created successfully.
Make sure you copy the access token now. You will not be able to see it again.

eyJhbGciOi]lUzl1 NilsinR5cCI61kpXVC]9_eyibGlIbnR]ZCl61k1 FUORIIFBIi

Close

A warning

This token will only appear once, so you must store it in a safe location for future use.

External Tool Configuration

Using Microsoft Excel as an example, and to open the OData dataset, the steps are as follows:

1. Use the Get Data functionality from the Data menu, as shown in the image below, and select the From
OData Feed option in the From Other Sources submenu:
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X
OData feed
® Basic Advanced
URL
https:fNM-PROD-CI‘cmf.critica[manufacturing.com:10102!ap\'f0dat4
0 Info
If this redirection does not happen or if the system throws an error, see the Credentials Cleanup section.
OData feed X

Anonymous B https://vm-prod-ci.cmf.criticalmanufacturing.com:10...

Use anonymous access for this OData feed.

Windows

Select which level to apply these settings to
Basic https://vm-prod-ci.cmf.criticalmanufacturing.com: 10102/ =

Web API

Organizational account

Back Cancel

3. Select the Basic option on the left side panel and paste your Access Token in the Password field and
select Connect (you can leave the User name field empty):
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4. If the access token is valid, the Navigator View should open and provide a list of all the available
Queries:
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Navigator

A GetExperimentsQuery &

(] Select multiple items Id Name Description StartDate Syst
Display Options ~ D; 2,00924E+18 E1-000000001 null 24-09-2020 13:36:34 +01.00

. . 2,00924E+18 E2-000000001 null 24-09-2020 13:39:35 +01:00
Fl Eﬁ https://VM-PROD-Cl.cmf.criticalmanufacturi.. A

CertificationManagedByMeQuery
chartByTypeOrParameter
GetAllMatenalTransfers

GetAreaByFacility
GetCertificationEmployeeQuery
GetDurablesForResourceViewQuery
GetEmployeeForCertificationQuery
GetExperimentsQuery
GetlLoadPortsForResourceView
GetMaterialsForResourceByStateForResour...
GetProductByStepAndProductGroup
GetProductByStepAndProductGroupAndPr...
GetProductGroupByStep
GetProductionOrders

GetResourceByArea
GetResourceByAreaAndResourceType

GetResourceConsumablePortsForResource...

D000 00088A

v
GetResourceDurablesForResourceView < >

elated Tables Load |~ Transform Data Cancel

Select

5. A sneak preview of the output data for each query is shown, allowing you to select the queries that
should be imported. After selecting Load, the data will be imported:

A [ [ o [ i () ) i[=

= - x

| 2009288418 £2 000000001 24052000 13:79 1 2009248418 £2 240924418 Ash Clean —_—

are required to correctly configure the OData feed.

On parameterized MES Queries, parameters are seen in the Excel navigator as $varName. In the example

Navigator

I Get x ] GetAreaByFacility

|| Select multiple items SArea_Facility Id Name

Display Options ~ [2 null null null
B GetAreaByFacility ~

B GetCertificationEmployeeQuery
[ GetCookies
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As expected, a query that includes a mandatory parameter without a default value defined will return no
data. Let us walk though this example to illustrate how to properly configure the OData feed. Additional
functionalities such as filtering, ordering, and paging are also supported when using the advanced query
options.

First, you need to know what sort of parameter $Area_Facility represents. In this case we can use the MES
Ul to try to run the same MES Query:

£ Query Parameters

itself will pass the Id of the Facility to the Query engine. This, however, is not a rule and depends on how
the MES Query is defined.

For this example, the target Facility for which you want to retrieve existing Areas is called Cookie Factory. At
this moment, the Id of the Cookie Factory Facility most likely is still unknown but can be consulted in the
MES Ul by simply opening the target Facility and copying from the Info section:

M Cookie Factory (Active)

~ DETAILS

Facility Information
Name: Cookie Factory @ Display Order: 6
. Description: Cookie Factory Facility . b bl %S[anda'd
— @ INFO <
ype: §= Cookie Production < No

Universal State: Active 1D: k No
2006291525520000006
Created by
& C\MPemfsu
- CMRemfsy
Created on:

Now that the parameter value is known, you can select the GetAreasByFacility entity in the Navigator view
and select Transform Data:
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Navigator

| Get x| GetAreaByFacility 2

] Select multiple items

SArea_Facility Id Name
Display Options ~ D‘; null null null

GetAreaByFacility ~
GetCertificationEmployeeQuery
GetCookies

GetDurablesForResourceViewQuery

MAaHAAA

GetEmployeeForCertificationQuery

i}

GetExperimentsQuery
Search results are limited to already expanded items

Select Related Tables load |~ Transform Data Cance

The Power Query editor should open, and you should select the Advanced Editor button:

| &2~ = | GetAreaByFacility - Power Query Editor

Home Transform Add Column View
> [:% Properties Lid Y, Eex 4| I Data Type: Text ~
G [ e ¥ HE L I =0
o _;1 ’ ™ Use First Row as Headers ~

Close & Refresh Choose  Remove Keep Remove Split Group 1

Load~  Preview~ L] Manage ¥ Columns ~ Columns~ Rows~ Rows~ Column~ By »ReplaceValues
Close Query Manage Columns Reduce Rows  Sort Transform

> [ fr ‘ = Source{[Name="GetAreaByFacility",Signature="table"]}[Data]

£ | E. | A8 SArea_Facility Blﬂg Id [~] A8 Name E‘

L

Oj' 1 null null null

Now you should replace the existing code by:
OData.Feed("<ODataURL>/<QueryName>?$filter=$VarName Eq 'value'", null, [ Implementation="2.0"])

Using the current example this line would be:

OData.Feed("<http://VM-PROD-CI.cmf.criticalmanufacturing.com:10082/api/odata/GetAreaByFacility>?
$filter=$Area_Facility Eq '2006291529520000006'", null, [ Implementation="2.0"])

3] Advanced Editor

GetAreaByFacility

Display Options ~ o

OData.Feed("http://VM-PROD-CI.cmf.criticalmanufacturing. com:18082/api/odata/GetAreaByFacility?¢filter=8Area_Facility Eq
' 2096291529520989206' ", null, [ Implementation="2.8"])

Select Done and you should be able to see the expected results:
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Il &~ = | GethseaByFacility - Power Query Editor
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PR ) PN VN [P P

HEBEREEE

[T |8 SAren_Faciiity [~ )23 10 - | A% Mame -

200€291529520000006
| 2006291529520000006

2006291529520000006

2006291529520000006
| 2006291523520000006
|200e291529520000008
| 2006291529520000006

2006291529520000006

2006291523520000006
| 2006291523520000006
|200e291528520000008
| 200e251528520000008

2006291529520000006
| 2006291523520000006
| 2006291529520000006
| 2008291528520000008
| 2008251528520000008
| 2006291529520000006

2, 00633

3, 00635

3, D0638E41

T T
BA_DestinationArea

BA_Scurcehrsa

Storagehres
Cookie Packaging
Cookie Manufact

@

2006291523520000006
20 |2006291529520000006
| 2008291529520000006
22 | 200€291525820000008
23 | 2006291529520000006

-

In case of error, check whether the parameter is numeric or string. If it is numeric, you should set the filter
as:

$filter=$Area_Facility Eq 2006291529520000006” instead of “$filter=$Area_Facility Eq
'2006291529520000006'

You can also apply additional conditions like filtering, sorting and pagination. Except for OData Functions,
all other conditions should be supported.

Filtering

Filtering by complex expression with AND / OR and selecting “Name” (Id is returned as null). Expression:

$filter=$Area_Facility Eq '2006291529520000006' AND Name ge 'Cookie' AND (Id Eq 1907180027250000002 OR
Id Ne 1907180027250000002 )&Sselect=Name:

e

fr || = obata.feea{ nttp: /1 v-PROD-CT.cnt ., criticalmanufacturing. com: 16652/ap1 /0daka/ GetAreabyFaci 1ity 8¢ i1ter~Sarea_Facility Eq '2006291529520000006" Name ge “Cookie' AND (Id Eq

1907180027250060002 OR Id Ne 1907180027250000002 )&fsclect=hame®, null, [ Implementation="2.8°])

Queries

| |48, sarea_saciiny =12 10
2006291529520000006
| 2006291529520000006
| 2006291529520000006
| 2006291529520000006
| 2006291529520000006
2006291529520000006
2006291529520000006
| 2006202529520000006
9 |2006291529520000006
| 10 |2006291529520000006
11 | 2006291529520000006
12 | 2006291529520000006
[ 13 .1005291539520000095
|14 | 2006291529520000006
|15 | 2006291529520000006
| 16 |2006291529520000006
17 | 2006291529520000006
18 | 2006291529520000006
19 | 2006291529520000006
20 | 2006291520520000006

e |~ e | in e | ro =

=

Ordering
Ordering by Name ascending, Id descending and retrieving the top 5 rows after skipping 5 rows. Expression:

$filter=$Area_Facility Eq '2006291529520000006'&S$Sorderby=Name asc, Id desc&$top=5&S$Skip=5:
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fr || = obats.Feed{ nttp: //VM-PROD-CI. cuf . criticalsanufacturing. con: 10082/ ani /odata/GethrealyFacility}$7ilterssaren_Facility Eq '2006201529520000006' SSorderbyshame ssc, Id deschStopsSSSSkipss®, A
null, { Inplementations*2.87))

i
.
1. 48, SArea_Facility =y 1 * || 2B, Name

1 | 2006291529520000006
91528520000006

2 |20
3 | 2006291528520000006
4 |2006291529520000006

5 | 2006291529520000006

Credentials Cleanup

If the system hangs when connecting to the OData feed, clearing the database credentials should solve the
problem.

File Home Insert Page Layout Formulas Data Query Review View H
% I:% D i D I:% P‘: [T] Queries & Connections @
@ = @ . Properties
Get From From From Table/ Recent Existing Refresh Stocks
Data ~ Text/CSV Web Range Sources Connections All~ [b’ Edit Links
1 Queries & Connections I C
From File >
S
B From Database >
mm From Azure >
-]

_H From Online Services >

:30 From Other Sources Ml cription B4 startDate systemstate B __cmf_html_Experi
24-09-2020 13:36 1

% Combine Queries > 24-09-2020 13:39 1
—

@ Launch Power Query Editor...
[%. Data Source Settings...
Query Options

|

Use the Get Data functionality from the Data menu, as shown in the image above, and select the Data
Source Settings option. In the following screen, select the endpoint causing the issue and select Clear
permissions. Select Delete in the next dialog to confirm the operation and repeat the connection
configuration.
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Legal Information

Disclaimer

The information contained in this document represents the current view of Critical Manufacturing
on the issues discussed as of the date of publication. Because Critical Manufacturing must
respond to changing market conditions, it should not be interpreted to be a commitment on the
part of Critical Manufacturing, and Critical Manufacturing cannot guarantee the accuracy of any
information presented after the date of publication. This document is for informational purposes
only.

Critical Manufacturing makes no warranties, express, implied or statutory, as to the information
herein contained.

Confidentiality Notice

All materials and information included herein are being provided by Critical Manufacturing to its
Customer solely for Customer internal use for its business purposes. Critical Manufacturing retains
all rights, titles, interests in and copyrights to the materials and information herein. The materials
and information contained herein constitute confidential information of Critical Manufacturing and
the Customer must not disclose or transfer by any means any of these materials or information,
whether total or partial, to any third party without the prior explicit consent by Critical
Manufacturing.
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binaries, designs, specifications, models, documents, layouts, images, photographs, animations,
video, audio, music, text incorporated into the Software), the accompanying printed materials,
and any copies of the Software, and any trademarks or service marks of Critical Manufacturing
are owned by Critical Manufacturing unless explicitly stated otherwise. All title and intellectual
property rights in and to the content that may be accessed through use of the Software is the
property of the respective content owner and is protected by applicable copyright or other
intellectual property laws and treaties.
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